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Chapter 1

Introduction

This documentation describes how to use the Tungsten Printix Cloud Print Management Service for 
flexible, secure, and mobile printing.

If you are a new user, follow the instructions in Getting started.

If you are an administrator, see the Printix Administrator Help.

Quick links
Use these links to quickly locate details about typical tasks:

• Register as a new user
• Install the Printix Client for Windows
• Open the Printix Client menu
• Print with Printix

• Print from Android phone or tablet
• Print from iPhone or iPad
• Print from Chrome

• Add printers
• Open the Printix App
• Printix Go
• Printix Product Support
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Chapter 2

Getting started

Before you can start using the Printix Cloud Print Management Service:

• Ask your administrator about your Printix Home.
• Register as a new user.
• Install the Printix Client on a Windows or Mac computer.
• Install the Printix App on your phone or tablet.

• Get Printix App for Android
• Get Printix App for iOS/iPadOS

Also, see these topics to help you get started:

• How to sign in
• How to reset your password
• How to open the Printix Client menu
• How to open the Printix App
• How to change the language

Printix Home
The Printix Home is a URL that represents your organization. It is required for specific work 
processes.

Example: The Printix Home for a fictional organization named Acme would be acme.printix.net, 
which is used as an example throughout the user documentation.

To obtain the Printix Home URL for your organization, contact your administrator.

Register as a new user
As described below, some registration methods may already be enabled by your administrator:
• Register with your Microsoft / Google Workspace / Okta / OneLogin account
• Register with your network user name and password
• Self-registration by email
• Request an email invitation

10

https://play.google.com/store/apps/details?id=net.printix.printixapp
https://itunes.apple.com/us/app/printix-app/id1391512097


Tungsten Printix User Guide

Register with your Microsoft / Google Workspace / Okta / OneLogin 
account

If your administrator enabled Microsoft, Google Workspace, Okta, or OneLogin authentication, you 
are automatically registered when you first sign in with your respective account. You also receive an 
email with the subject Get started with Printix.

Register with your network user name and password
If your administrator enabled Active Directory authentication, you are automatically registered 
when you first sign in with your network account. You also receive an email with the subject Get 
started with Printix.

Self-registration by email
1. Open a web browser and enter your Printix Home URL.

Example:  acme.printix.net
2. On the sign-in page, select Menu  > Register in the top right corner.

3. On the Register page, enter your email address.
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4. Select Register.
You receive an email with the subject Welcome to Printix.

5. Open the email and select Get started.
If you do not see the email within a few minutes, check your spam/junk mail folder.

6. On the Activate your print account for {organization} page:
• Enter your full name.
• Enter your password.
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7. Select Activate.

Request an email invitation
1. Contact a member of your organization with a system manager role and ask to be invited by 

email.
You receive an email with the subject Welcome to Printix.

2. Open the email and select Get started.
If you do not see the email within a few minutes, check your spam/junk mail folder.

3. On the Activate your print account for {organization} page:
• Enter your full name.
• Enter your password.

4. Select Activate.

Install the Printix Client for Windows
• Download the installer file
• Install the Printix Client
• Sign in

13
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Download the installer file
On your Windows computer:

1. Open a web browser and enter the Printix Home URL for your organization followed by /
download.
Example:  acme.printix.net/download

2. Select Download Printix Client.

 Do not rename the installer file, because it prevents the Printix Client from working with 
your Printix Home.

Install the Printix Client
Printix Client requires .NET Runtime 6.

Open and run the file you downloaded:
1. Double-click CLIENT_{home}_{id}.EXE.

 Microsoft Defender SmartScreen may prevent the installer from running. You can safely 
select Run anyway and proceed with the installation of the Printix Client.

If a User Account Control dialog box appears, select Yes when prompted to allow the Printix 
Client Setup program to make changes on this computer.

2. Change the setup language if required. Select OK.
The Setup - Printix Client wizard appears.

3. Select Next.
4. Select Install.

The installation is started.
5. After the installation is complete, select Finish.

Sign in
After the installation, the sign-in page appears in a web browser. See How to sign in.
• Sign-in is required the first time you start the Printix Client.
• After signing in to the Printix Client, you can close the browser window.

 Sign-in to the Printix Client is automatic on Microsoft Entra joined Windows 10 and 11 
computers and works with the Pro, Enterprise, and Education editions. Microsoft does not support 
Microsoft Entra join on Windows Home editions.

Install the Printix Client for Mac
• Download the installer file
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• Install the Printix Client
• Sign in

Download the installer file
On your Mac computer:

1. Open a web browser and enter the Printix Home URL for your organization followed by /
download.
Example:  acme.printix.net/download

2. Select Download Printix Client.


• Do not rename the installer file, because it prevents the Printix Client from working with 

your Printix Home.
• On Mac computers running macOS 10.15.1 or higher, you may get the message: Printix 

Client.pkg can't be opened because Apple cannot check it for malicious software. See:
FAQ - Printix Client for Mac will not install on macOS.

• Mac computers with Apple M2 require Printix Client for Mac version 1.3.1239 or higher. 
Submit a support request if you need a newer version.

Install the Printix Client
Open and run the file you downloaded:

1. Open the Downloads folder, which is typically available from the Dock at the bottom of the 
screen.

2. Double-click CLIENT_{home}_{id}.DMG.
After a few seconds, the Printix Client dialog box appears.

3. Hold down the Control ^ key and right-click the Cardboard box  (Printix Client.pkg), then 
select Open With > Installer.
A warning message appears.
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4. Select the option (typically Open or OK) to continue the installation.
5. If the Install Printix Client dialog box does not appear, repeat steps 2 to 4 or change your 

system settings as described in the related Apple documentation.

 Printix is an identified Apple developer and the Printix Client software is signed with our 
Apple developer ID.

6. In the Install Printix Client dialog box, select Continue. If you are prompted to select a 
destination, select Install for all users of this computer, then select Continue.

7. Select Install.
8. Enter your password to allow installation. Select Install Software.
9. Select Close to finish installing the Printix Client.

Sign in
After the installation, the sign-in page appears in a web browser. See How to sign in.
• Sign-in is required the first time you start the Printix Client.
• After signing in to the Printix Client, you can close the browser window.

 It may take about a minute before the Sign in dialog box appears.

How to sign in
Your administrator configures which sign-in options are available to you on the sign-in page.
• Sign in with Microsoft
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• Sign in with Google
• Sign in with Okta
• Sign in with OneLogin
• Sign in with email

• You can also select this option to sign in with your network account.

Sign in with your Microsoft account
1. Select Sign in with Microsoft.

If you were already signed in to the browser with your work or school account, you are signed 
in automatically.

2. On the Microsoft sign-in page:
• Enter your work or school account.
• Enter your password.

3. Select Sign in.
4. If prompted, select Accept to grant permissions to Printix.

Sign in with your Google Workspace account
1. Select Sign in with Google.

If you were already signed in to the browser with your work or school account, you are signed 
in automatically.

2. On the Google sign-in page:
• Enter your work or school account.
• Enter your password.

3. Select Sign in.

Sign in with your Okta account
On the Printix App for Android and iOS/iPadOS, to sign in with Okta, select Alternate sign in, enter 
your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in method 
your administrator has enabled, such as Okta.
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1. Select Sign in with Okta.
If you are already signed in to the browser with your Okta account, you are signed in 
automatically.

2. On the Okta sign-in page:
• Enter your account name.
• Enter your password.

3. Select Sign in.

Sign in with your OneLogin account
On the Printix App for Android and iOS/iPadOS, to sign in with OneLogin, select Alternate sign in, 
enter your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in 
method your administrator has enabled, such as OneLogin.
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1. Select Sign in with OneLogin.
If you are already signed in to the browser with your OneLogin account, you are signed in 
automatically.

2. On the OneLogin sign-in page:
• Enter your account name.
• Enter your password.

3. Select Sign in.

Sign in with your email address
On the Printix App for Android and iOS/iPadOS, to sign in with email, select Alternate sign in, enter 
your Printix Home (such as acme.printix.net), then select OK. Then, you can select a sign-in method 
your administrator has enabled, such as email.
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If you registered with your email address, select Sign in with email and enter your email address 
and password. Your email address serves as the user name.

If Active Directory authentication is enabled, you can enter your network user name instead of your 
email address.
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Pick a Printix Home

When you sign in to the Printix App for Android or iOS/iPadOS or from printix.net, you are prompted 
to select a Printix Home if you:
• Sign in with Microsoft, and Microsoft Entra ID is used with multiple Printix Homes.
• Sign in with Google, and Google Workspace is used with multiple Printix Homes.
• Sign in with Okta, and Okta is used with multiple Printix Homes.
• Sign in with OneLogin, and OneLogin is used with multiple Printix Homes.
• Sign in with email, and your Printix account is registered with multiple Printix Homes.

To change language, select Menu  > Language.

To change to another Printix Home, select Menu  > Change home in the Printix App.

22
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How to reset your password
If you forget your network password, contact your administrator or use the following procedure to 
reset it.

To change your password, or if you have forgotten your password:
1. On the sign-in page, select Forgot password.

This option is not supported for the Printix App for Android and iOS/iPadOS.
2. On the Reset password page, enter the email address used when you registered.
3. Select Send.

An email is sent to you. If you do not see the email within a few minutes, check your spam/junk 
mail folder.

4. Open the email with the subject Reset password instructions and select Reset password.
If you ignore the email, your password is not changed.

5. On the Reset password page, enter your new password.
6. Select Reset.

How to change the language
The default language is based on the language of your browser and computer OS.

If you change the language in the Printix App, the selected language is stored in your profile.

The selected language is stored as browser data for these pages:
• Sign-in page
• Download page

Change the language for Printix App
1. In the Printix App, select Menu  > Language.
2. Select the language to use.

• If you are signed in, your choice of language is stored as part of your profile.
• Otherwise, it is stored as browser data.

Change the language for Printix Client
Language is inherited from the computer operating system (OS). If the OS language is not among 
the supported languages, it uses the language saved as part of the user's profile in Printix. If no 
language is saved in the user's profile, English is used. To change the language in your profile, you 
need to sign in to the Printix App and change the language there (see the steps above).
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Print with Printix

You can use the following print-related functions while printing with Printix:

• Select a print method
• Print
• Print Later

• Print Anywhere
• Print on both sides
• Print to a printer at home
• Print from Android phone or tablet
• Print from iPhone or iPad
• Print from Chrome
• Release documents
• Reprint

Documents you print with Print Later or Print Anywhere are not printed immediately. Instead, they 
are stored in the cloud or on your computer until you release them at the printer.

1. On your computer, open the item to print.
2. On the File menu, select Print.
3. Select a specific printer or Printix Anywhere.

• Specific printer
• If you select a specific printer, you can print the document only at that printer.

When searching for a printer, you can identify each printer by its printer ID. The printer ID 
is a unique, three-letter ID that is automatically added to the name of all Printix printers.
Example:
• Reception ASD
• Sales BNM

 Your administrator can optionally configure the printer ID to not be visible to users.

If you cannot find a specific printer, see how to add printers.
• If you select a specific printer, you need to set a preferred print method to determine how 

your document is printed:
• You can print directly to the selected printer without any delay.
• You can use Print Later to send the document to the print queue, and subsequently 

use your phone or tablet to release the document.
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• Printix Anywhere
If you select Printix Anywhere, you can release the document at any Printix printer.

4. Select Print.
• If you selected a printer and your preferred print method is Print, your document is printed 

immediately at the selected printer.
• If you selected a printer and your preferred print method is Print Later, use your phone or 

tablet to release the document at the selected printer.
• If you selected Printix Anywhere, use your phone or tablet to release the document at any 

Printix printer.

Select a print method
The preferred print method is Print Later by default. To change your preferred print method, follow 
the steps below.

If the Internet connection is lost, you cannot use Print Later until Printix is online again. See Can I 
print while my Internet connection is lost?.

1. Open the Printix Client menu.
2. Configure your preferences.

• Preferred print method: Print
Prints the document directly to the selected printer without any delay.

• Preferred print method: Print Later (default)
Does not print the document until you release it through your phone or tablet.
This option requires your administrator to enable it. See "How to enable Print Later" in the
Printix Administrator Help.

• Ask me to select print method at every print
Prompts you to select Print or Print Later every time you print from your computer. If you 
do not make a selection within 30 seconds, your preferred print method is automatically 
selected and no print notification appears.

• Show print notification
If selected, a notification bar appears for a few seconds when you print, displaying the 
document being printed.

Print
The document is printed immediately and directly at the selected printer.
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1. Open the Printix Client menu.
2. Select Preferred print method: Print.
3. Clear Ask me to select print method at every print.
4. Clear Show print notification.
5. On your computer, open the item to print.
6. On the File menu, select Print.
7. Select a Printix printer, then select Print.

Print Later
With Print Later, your documents remain in the print queue until you arrive at the selected printer 
and use your phone or tablet to release them.

This is the ideal method if you need to print confidential documents and you want the printer to 
perform finishing options (such as drilling and embossing) on your printed document.

1. Open the Printix Client menu.
2. Select Preferred print method: Print Later.
3. Clear Ask me to select print method at every print.
4. On your computer, open the item to print.
5. On the File menu, select Print.
6. Select a printer, then select Print.

Example:  Reception ASD
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You cannot change the selected printer after you select Print.
Your document is not printed until you release it.

7. Release the document.

Print Anywhere
With Print Anywhere, after selecting a document to print from your computer, you can go to any 
available Printix printer and start printing at that printer. Your document is kept in the print queue 
until you release it at the printer, or from your phone, tablet, or computer.

Due to printer limitations or restrictions configured by your administrator, you may not be able to 
automatically perform finishing options (such as drilling and embossing) on your printed document 
if you use Print Anywhere. However, if this limitation is not a concern, Printix Anywhere could very 
well turn out to be the only printer you need on your computer.

1. On your computer, open the item to print.
2. On the File menu, select Print.
3. Select Printix Anywhere, then select Print.

Your document is not printed until you release it.
4. Release the document.

Print on both sides
The name of the control for printing on both sides may vary based on your operating system and 
printer:
• Double-sided
• Two-sided
• 2-sided
• Duplex
• Front-and-back
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 Printing on both sides is not supported on the Print Anywhere queue when using the default
Print to PDF configuration.

Windows
1. Open the item to print.
2. Select File > Print, or press Ctrl+P.
3. In the Print dialog box, enable printing on both sides.

If you cannot find this print control, select Preferences or Printer properties.

Mac
1. Open the item to print.
2. Select File > Print, or press Command+P.
3. In the Print dialog box, enable printing on both sides.

If you cannot find this print control, select Show Details.

Print to a printer at home
If your organization enabled home office printing for your business laptop, you will notice the 
following behavior:
• When you power on your computer at home, it attempts to discover your printers at home.

• Your computer can only discover powered-on printers.
• If the printer is a USB printer, it must be attached to you computer.

• When at home, your computer installs a print queue for your printers at home.
This Printix-managed home office print queue must be used for work-related printing. Data is 
collected.
• The first part of your organization's Printix Home (such as acme.printix.net) is appended to the 

printer name and displayed within parentheses.
Example: myprinter (acme)

• Any existing print queue (myprinter) for the home printer remains untouched and can be used 
for personal printing. Data is not collected.

To print work-related documents, print as usual, and select the Printix-managed home office print 
queue.

Example: myprinter (acme)

To print personal documents, print as usual, and select the print queue without the appended 
parenthesis.

Example: myprinter

28



Tungsten Printix User Guide

Print from Android phone or tablet
This feature requires your administrator to enable mobile print.

1. On your Android phone or tablet, open the application to print from.
• To find the print option, select More  in the upper-right corner.
• If you cannot find the print option, see the documentation provided with your application.

2. Select Print.
• Select the down arrow next to the selected printer's name and select your Printix printer 

from the list.
• Optionally, configure the number of copies and other print preferences.
• If this is the first time you are printing to this printer, a Use Printix App? dialog box may 

appear. Select OK.

3. Select the Printer icon to print.
The document is printed.
The document is pending to be released from the Printix App if:
• You selected Printix Anywhere as your printer.
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• Your administrator configured that you must use Print Later.

Print from iPhone or iPad
This feature requires your administrator to enable mobile print.

Ensure the Printix App is installed on your iPhone or iPad.
1. On your iPhone or iPad, open the application to print from.

• To find the print option, select the Share  icon or select More .
• If you cannot find the print option, see the documentation provided with your application.

Not all applications support printing from an iPhone or iPad.
2. Select Print .

• Use Select printer to select a Printix printer.
• Optionally, configure the number of copies and other print preferences.
• If this is the first time you are printing to this printer, it appears locked and a Password 

required for {printer} dialog box appears. To unlock the printer, you need to enter your
AirPrint password, which you can get from the Printix App for iOS/iPadOS.

 Make sure the iPhone or iPad is not in Low Power Mode, which prevents the Printix App 
from running in the background and displaying the Printix AirPrint printers.

30



Tungsten Printix User Guide

3. Select Print in the upper-right corner.
The document is printed.
The document is pending to be released from the Printix App if:
• You selected Printix Anywhere as your printer.
• Your administrator configured that you must use Print Later.

How to get your AirPrint password
Your AirPrint password is the same for all printers. You need to enter your AirPrint password only 
once per printer.

1. On your iPhone or iPad, open the Printix App for iOS/iPadOS.
2. Select Menu  > AirPrint password.

If you cannot find this menu item, close and reopen the Printix App.
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A dialog box appears with a password.
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3. Copy the password to the clipboard.
4. Return to the Password required for {printer} dialog box.

• On iPhone X: Swipe up from the bottom to the middle of your screen and hold until you see 
the app switcher. Swipe left or right to find the application. Select the application.

• On other iPhones: Select the Home button twice. Swipe left or right to find the application. 
Select the application.

5. Paste the password into the Password field.
• Select and hold the Password field until the text magnifies.
• When the text is magnified, remove your finger and select Paste.
• Enter a user name, which can be any string (such as noname).
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 If you leave the Username field empty on an iPad, the Password required for {printer}
dialog box appears every time you print to the printer.

6. Select OK.

Print from Chrome
1. Verify that the Printix extension for Google Chrome is installed.
2. Sign in to the Printix extension.
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3. Open the item to print in the Google Chrome browser.
4. Select Print on the Chrome menu (or press Ctrl+P).
5. Select the current Destination, then select See more.
6. In the Select a destination dialog box, select a Printix printer as identified by the text Printix

 on its right.
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Print Anywhere documents printed from Chrome can, unless the printer's QR code or NFC 
tag is scanned, be released only to printers that have a print queue with Via the cloud (On all 
networks) selected.

7. Optionally, modify the available settings or set the print method to Print or Print Later.
8. Select Print.
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Available settings
The available settings depend on the properties of the Printix printer:
• Pages

Always available.
• Copies

Always available.
• Layout

Available, unless the document is a PDF, or if the printer supports PDF printing and Process PDF/
XPS is disabled.

• Color
Available, unless the printer does not support color, or if the printer supports PDF printing and
Process PDF/XPS is disabled.

Select More settings to access the following settings:
• Paper size

Always available.
• Pages per sheet

Available, unless the printer does not support it.
• Margins

Available, unless the document is a PDF.
• Scale

Always available.
• Options

• Print on both sides
Available, unless the printer does not support two-sided printing.

• Headers and footers
Available, unless the document is a PDF.

• Background graphics
Available, unless the document is a PDF.

 The print driver on your computer may not be able to process your settings for Color, Paper 
size, and Two-sided. The Two-sided setting is ignored while using Print Anywhere.

Select print method
You can select a print method from Google Chrome without opening the Printix Client menu.

 Not available for Print Anywhere. Not available if Print Later is disabled or if your 
administrator configured that you can only use Print Later.

1. Select More settings, then select Advanced settings.
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2. In the Advanced settings dialog box, select a print method:
• Print: The document is printed immediately at the selected printer.
• Print Later: The Printix App must be used to release the document at the selected printer.

3. Select Apply.
4. Select Print.
5. If required, open the Printix App or sign in at the printer to release the document.

Release documents
When you print with Print Later or Print Anywhere, you have multiple ways to release your 
documents.
• Scan a QR code to release documents at a specific printer
• Scan an NFC tag to release documents at a specific printer
• Release a Print Later document
• Release a Print Anywhere document
• Release documents with the printer's touchscreen control panel

Scan a QR code to release documents at a specific printer

You can select a Printix printer by scanning the QR code on the printer ID sign of the physical 
printer. This option is helpful if you do not know the name of the printer.

1. Go to any Printix printer with your phone or tablet (with Printix App installed).
2. Open the Printix App on your phone or tablet.

You see a list of documents you can release.
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3. If you do not want to release all documents, only select the documents you want to release.
If you do not select documents, the printer attempts to release all listed documents, except
Print Later documents that must be printed at a different printer.

4. Select the QR code icon  at the top of the page.
If you selected documents in the previous step, you can also select Scan at the bottom of the 
page.

 The QR code icon  and the Scan button are unavailable if the printed ID method does 
not include QR code.

• Android: If prompted, select Allow to allow the Printix App to take pictures and record 
videos.

• iOS/iPadOS: If prompted, select OK to allow the Printix App to access the camera to scan QR 
codes.

5. Use the camera to scan the QR code on the printer ID sign.
• The message Invalid QR code appears if the QR code does not reference a printer. Select

Close.
• The message Document is not for this printer appears if you selected a different printer

for a Print Later document. Select Close.
6. If this printer has multiple print queues, you may be prompted to select one.

You are not prompted if only one of these print queues is marked as a favorite .
The message No print queue appears if no valid print queue exists for the scanned QR code.
The documents start to print.
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Scan an NFC tag to release documents at a specific printer

You can select a Printix printer by scanning the NFC tag on the physical printer. This option is helpful 
if you do not know the name of the printer.

1. Go to any Printix printer with your phone (with Printix App installed).
2. Open the Printix App on your phone.

• Android: Most Android phones support NFC.
• iOS: Apple iPhone 7 and above with iOS 11 or higher can be used to scan NFC tag.

You see a list of documents you can release.
3. If you do not want to release all documents, only select the documents you want to release.

If you do not select documents, the printer attempts to release all listed documents, except
Print Later documents that must be printed at a different printer.

4. Select the NFC tag icon  at the top of the page.
If you selected documents in the previous step, you can also select Scan at the bottom of the 
page.

 The NFC tag icon  and the Scan button are unavailable if the printed ID method does 
not include NFC tag.
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5. When your phone displays Ready to scan, hold the phone close to the NFC tag to start 
scanning.
• For optimal scanning, the distance to the NFC tag should be less than 4 cm.
• The phone's NFC detection area depends on the mark and model, and is typically on the 

backside near the top of the phone.
• The message Invalid NFC tag appears if the NFC tag is not registered with a printer. Select

Close.
• The message Document is not for this printer appears if a Print Later document you 

wanted to release at this printer is supposed to be printed at a different printer. Select Close.
6. If this printer has multiple print queues, you may be prompted to select one.

You are not prompted if only one of these print queues is marked as a favorite .
The message No print queue appears if no valid print queue exists for the scanned NFC tag.
The documents start to print.

Why does my Android phone display: New tag collected?
The message "New tag collected" may appear when an Android phone is held near an NFC tag 
without selecting the Scan button or the NFC tag icon  first. Just ignore the message by selecting
Back, and proceed to select the Scan button or the NFC tag icon .

Release a Print Later document
1. Open the Printix App for Android or iOS/iPadOS.

You can also open the web app.
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2. Select a Print Later document.
• The selected printer is listed above the documents.
• The Printix App checks if printing is possible based on the availability of the selected printer 

and document (stored in the cloud or on your computer).
3. Go to the selected printer with your phone or tablet, unless you used the web app.

If you are using the web app, go to the selected printer after the next step.
4. Select Print at the bottom of the page.

• Documents are automatically deleted if you do not print them within a specified period 
(default is 24 hours).

Release a Print Anywhere document
1. Open the Printix App for Android or iOS/iPadOS.

You can also open the web app.
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2. Select a Print Anywhere document.
3. Select Select printer or Printer at the bottom left corner of the page to select or change the 

printer.
• The Printix App checks if printing is possible based on the availability of the selected printer 

and document (stored in the cloud or on your computer).
• Mobile-printed Print Anywhere documents can, unless the printer's QR code or NFC tag is 

scanned, be released only to printers that have a print queue with Via the cloud (On all 
networks) configured.

• Chromebook-printed Print Anywhere documents can, unless the printer's QR code or NFC 
tag is scanned, be released only to printers that have a print queue with Via the cloud (On 
all networks) configured.

4. Go to the selected printer with your phone or tablet, unless you used the web app.
If you are using the web app, go to the selected printer after the next step.

5. Select Print at the bottom of the page.
• Documents are automatically deleted if you do not print them within a specified period 

(default is 24 hours).
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Reprint
From the Printix App (from your phone, tablet, or computer), you can reprint documents that were 
deleted or printed within the previous 12 hours.

You can reprint documents from a different device than you originally printed from. However, 
unless you used Print Anywhere, you cannot change the printer.
• Example: You printed from a computer, but you can reprint from phone without doing anything 

on your computer.

1. Open the Printix App.
2. Select Menu  > Recents.
3. Select the documents.
4. Select Print at the bottom of the page.

• To return to the Print page, select the Blue clock .
• To permanently delete a recent document, select the document and select Delete .
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Printix Client

With the Printix Client, you can automatically add printers to your network and install print drivers.

The Printix Client runs on Windows and Mac computers. No manual effort is required to maintain 
the Printix Client, because it silently updates itself to the latest certified version.

The Printix Client supports one gateway per network adapter.

See also:
• Install the Printix Client for Windows
• Install the Printix Client for Mac

Open the Printix Client menu
1. Do one of the following:

• Windows computer: Locate the task bar.
You may need to select the arrow next to the notification area.

• Mac computer: Locate the menu bar.
2. Select the Printix  icon.

If it does not appear, install the Printix Client for Windows or Mac.
The Printix Client menu appears.
• If you are already signed in, your name appears next to Sign in as another user. Otherwise, 

select Sign in.
• If you have issues while signing in to the Printix Client, your administrator can refer to "Sign-

in issues" in the Printix Administrator Help.

Printix Client menu
• Printers

Adds printers and installs print drivers.

• See what's printing
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Displays a list of the documents the Printix Client is printing.

• Release and print documents
Opens the Printix App in a web browser where you can manage and print documents.

• Preferred print method: Print
Prints your document directly to the selected printer.
Not available if Print Later is disabled or if your administrator configured that you must use Print 
Later.

• Preferred print method: Print Later
Stores the printed document until you release it using your phone or tablet.
Not available if Print Later is disabled or if your administrator configured that you must use Print 
Later.

• Ask me to select print method at every print
If selected, the Select print method dialog box appears every time you print. Your preferred 
print method is pre-selected in the dialog box. If you do not respond, it closes after 30 seconds, 
prints using your preferred print method, and no print notification appears. Not available if Print 
Later is disabled or if your administrator configured that you must use Print Later.

• Show print notification
If selected, a print notification is displayed every time you print.

• Open Printix Administrator
Opens the dashboard for administrators.

• Help
Opens the User Help in a web browser.

• Sign in
Required the first time you use the Printix Client. If you are already signed in, your name is 
displayed.
Example: Sign in as another user (Now: John Smith (Microsoft))

Add printers
1. Open the Printix Client menu.
2. Select Printers.
3. Select the printers to install.

If you have many printers to select from, you can search for printers. The search is not case-
sensitive.

4. Select Add.
After installation, the printers are listed as either Installed  or with Error  (installation 
failed).

5. Select Finish.
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Identify the printer
Your administrator may have configured the Printix Client to convert the printers in your 
organization to Printix printers. Other printers, such as those you use at home, are not changed. 
Any further printers you add to Printix through the Printix Client are also converted to Printix 
printers.

To help you identify printers, when a printer is converted to a Printix printer, its name is 
automatically extended with a unique, three-letter printer ID.

Example:
• Reception ASD
• Sales BNM

The printer ID can also appear on the ID sign mounted on the physical printer.

Your administrator can optionally configure the printer ID to not be visible to users.

Printers are also identified by their QR code and NFC tag.

Set the default printer
By default, Windows manages the default printer. To turn off this behavior:

1. Press Windows+I.
The Settings window appears.

2. Select Devices (or Bluetooth & devices on Windows 11).
3. Select Printers & scanners.
4. Turn off Let Windows manage my default printer at the bottom of the page.
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Printers & scanners on Windows 10

Set default printer on Windows
1. Press Windows+I.

The Settings window appears.
2. Select Devices (or Bluetooth & devices on Windows 11).
3. Select Printers & scanners.
4. Select the printer and select Manage.

On Windows 11, you only need to select the printer.
5. Select Set as default.
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Selected printer on Windows 10

Alternatively, set default printer using the Control Panel
This method is not available on Windows 11.

1. Open the Control Panel and select Devices and Printers.
2. Right-click a printer and select Set as default printer.
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Set default printer on a Mac
1. In the Apple menu, select System Settings > Printers & Scanners.

On macOS 12 or lower versions, select System Preferences instead of System Settings.
2. Select the menu labeled Default printer and select the preferred printer.

If you select Last printer used, the computer remembers the last printer you used at your 
current network location.

Remove printers
If you no longer use a printer, you can delete it from your list of printers.

Windows
1. Open the Control Panel and select Devices and Printers.
2. If you use Windows 11, select Printers & scanners.
3. Select the printer and select Remove device (or Remove on Windows 11).

Mac
1. In the Apple menu, select System Settings > Printers & Scanners.

On macOS 12 or lower versions, select System Preferences instead of System Settings.
2. Select the printer and select Remove Printer.

On macOS 12 or lower versions, select Delete instead.
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See what's printing

To access this page:
1. Open the Printix Client menu.
2. Select See what's printing.

Documents are only visible for a short period of time, unless they are queued behind other 
documents or waiting for the printer to become available.
• Printer

Name of the printer.
• Document name

File name for the document.
• Pages

Number of pages in the document.
• Size

Size of the document.
• Started

The date and time the document was submitted.
• Status

Indicates the current state, such as:
• Waiting

Waiting for the printer to become ready.
• Waiting to reserve printer

Another Printix user is printing on this printer, and during this time, the printer is 
reserved. As soon as that user's documents are printed, the printer is no longer reserved. 
If no communication occurs, the printer reservation is automatically cleared after 5 
minutes. By reserving the printer, other users' documents are not intermixed with your 
documents, which reduces the risk of mistakenly collecting other users' documents from 
the printer's output bin.

• Connecting
Connecting to the printer.

• Printing
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The document is being transferred to the printer and printed.
• Error

An error has occurred.
• Printer error

An error has occurred on the printer. Check its status and resolve the error, typically by 
restarting the printer.

Uninstall the Printix Client
Follow these instructions to uninstall the Printix Client from Windows and Mac computers.

If you uninstall the Printix Client, your Printix printers are converted to standard network printers.

The printer IDs are removed from the printer names. Your administrator may have configured 
printer IDs to not be visible to users.

Example: Reception ASD changes to Reception.

Windows
1. Open the Control Panel and select Programs and Features.
2. Select Printix Client and select Uninstall.

If Printix Client was installed with Windows Installer (MSI), select the Printix Client without 
Printix logo (smallest size).

3. You are prompted to confirm the uninstallation. Select Yes.
The uninstallation is complete.

4. Select OK.
Alternatively, you can run unins000.exe in the Printix Client installation folder.

 If your organization has used, for example, Microsoft Endpoint Manager to deploy Printix 
Client as a required application, then Printix Client will be installed again.

Mac
1. Open the Printix Client menu.
2. Press the Option key to toggle Sign in to Uninstall.

On a Windows keyboard, press the Alt key instead of the Option key.
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3. Select Uninstall.
If the uninstallation fails, it could be because you are not signed in. Select Sign in and then 
select Uninstall again. Alternatively, you can run the script:
sh /Users/Shared/.Printix.net/Service/uninstallMac.sh

On macOS 10.15 or older, you should use:
sudo /Users/Shared/.Printix.net/Service/uninstallMac.sh
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Printix App

The Printix App is used to release documents with Print Later or Print Anywhere. The Printix App 
is available in a web browser or as a mobile app:
• Get Printix App for Android
• Get Printix App for iOS/iPadOS

You can open the web app by selecting Release and print documents in the Printix Client menu or 
by entering {your Printix Home}.printix.net in a web browser.

Compared to the web app, the mobile app offers these advantages:
• Only sign in once.
• Integrated QR code scanning.
• Integrated NFC tag scanning.
• Printing to Printix-managed printers is enabled for mobile print.

Open the Printix App
You can open the Printix App on your phone, tablet, or computer.
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Open the Printix App on your phone or tablet
Android
• Select the Printix App  on your Android device.

Get the Printix App for Android

iOS/iPadOS
• Select the Printix App  on your iPhone or iPad.

Get the Printix App for iOS/iPadOS

Web browser

Use any of the following options:
• Visit printix.net and select Menu  > Sign in.

When prompted to select a Printix Home, select Printix App under the appropriate Printix Home.
• Select the Printix App link in the email with the subject Get started with Printix.
• Open a web browser and enter the Printix Home URL for your organization.

Example: https://acme.printix.net
Do not put www in front of the address, because your browser will report the page as not 
private, untrusted, or as having problems with the security certificate.

 If you sign in with Microsoft or Google through printix.net, you are prompted to sign in every 
time. To avoid signing in every time, either sign in with email, bookmark the Printix App URL in 
your web browser, or install the Printix App for Android or iOS/iPadOS.

Open the Printix App on your computer
The Printix App opens in a web browser.

Use any of the following options:
• Visit printix.net and select Sign in.

When prompted to select a Printix Home, select Printix App under the appropriate Printix Home.
• Open the Printix Client menu and select Release and print documents.
• Select the Printix App link in the email with the subject Get started with Printix.
• Open a web browser and enter the Printix Home URL for your work or school.

Example: https://acme.printix.net
Do not put www in front of the address, because your browser will report the page as not 
private, untrusted, or as having problems with the security certificate.

 If you get a blank screen, you may have to clear your browsing data.
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Sign in through the mobile app

1. Select Alternate sign in on the sign-in screen.
You must use the Printix App for Android or iOS/iPadOS to see this option.

2. Enter your Printix Home, then select OK.
3. Sign in with one of the enabled sign-in methods.

Printix App menu
Open the Printix App and select Menu  in the top right corner to access the functions. The open 
menu displays the version number in the top right corner.
• Print
• Printers
• Capture (only available in the mobile app)
• Recents
• History - Print
• History - Capture
• Cards and codes
• Change home
• Printer ID method (only available in the mobile app)
• AirPrint password (only available in the mobile app)
• Diagnostics (only available in the mobile app)
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• Language
• Help
• Sign out

Print
Lists the documents you can print. Depending on your selected print method, documents may be 
grouped as:
• Print Later documents

These are the documents you selected to print with Print Later. You can only release them at the 
printer you specified. Documents are grouped by printer.
See How to release Print Later documents.

• Print Anywhere documents
These are the documents you selected to print with Print Anywhere. Before you can print, you 
must select a printer. You can select any Printix (ASD, BNM) printer. Your last used printer is 
selected by default.
See How to release Print Anywhere documents.

 With the Printix App for Android and iOS/iPadOS, you can also scan a QR code or an NFC tag to 
release documents.

Select a printer
1. Select a document.
2. Select Select printer or Printer at the bottom left corner of the page to select or change the 

printer.
A list of printers appears.
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 Favorite printers only appear in this list if your administrator enabled both Via the cloud
and Add print queue automatically in the print queue settings.

• Selecting a printer or selecting outside the list closes the list.
• Select Info  to see more information and the status of the printer.
• Select the Star  to remove the printer from the list of favorites.
• Select Show all to open the Printers page, where you can search for printers.

Printer information
1. Select Info  to see information about the printer:

• ID, Name, Status, Model, Location, and Features.
• The Features include color printing, 2-sided printing, and PDF printing.

2. Select Close.
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Document information
1. Select More  and Info  to see information about the document:

• Name: Name of the document.
• Pages: Number of pages in the document.
• Created: Date and time when the document was created.
• Stored on computer: Name of the computer where the document is stored.
• Cloud storage: Indicates if the document is stored in the cloud.

2. Select Close.

Delete document
• To delete a document, select More  and Delete.
• To delete multiple documents, select them and select Delete .
• Documents are automatically deleted after a specified period (default is 24 hours).

Reprint recent documents
Select the Clock  to list documents that were deleted or printed within the previous 12 hours.
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Printers

Lists the printers.
• Select the Hollow star  to make the printer a favorite.
• Select the Solid star  to remove the printer from the list of favorites.
• Select Info  to see information about the printer:

• ID, Name, Status, Model, Location, and Features.
• The Features include color printing, 2-sided printing, and PDF printing.

 Printing to a printer automatically makes the printer a favorite. Printers without a print queue 
do not appear.

Search
1. Enter a name or printer ID in the search bar.
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The search is not case-sensitive.
2. Press Enter to start the search.

If no printers match your search criteria, select Back.

Filters
1. Select Filters.
2. Select Network, then select the networks to filter with.

Each filter appears as a text box above the list of printers.
3. Select Close.
4. If you added too many filters, select X in a filter's text box to remove it, or select Filters > Clear 

all filters to remove all filters.

Capture
Using the Printix App on your phone or tablet, you can use the camera to capture or select existing 
photographs.
• Capture with Android phone and tablet
• Capture with iPhone and iPad

Capture with Android phone and tablet

 Capture is intended for text-based documents and the output is delivered in black and white.

Use the camera to capture
1. On your Android phone or tablet, open the Printix App.
2. Select Menu  > Capture.

• Alternatively, you can select Capture  on the Print page.
3. Select a box with the appropriate settings.
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Example:
• File type: PDF
• Image quality: Medium
• Destination: Email

4. Follow the instructions, then take a photo.
• If you do not want to proceed, select X to cancel and return to the list of boxes.
• The built-in, automatic crop function works best if the document is placed on a darker 

background.
• Select the lightning icon to toggle the flashlight.
• If prompted, select Allow to allow the Printix App to take pictures.
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5. Preview the photo. Optionally, select Retake, or select Edit to Crop or Rotate the image.
6. Select Use.

 If you did not crop the image, it is cropped automatically. If you are not satisfied with the 
automatic cropping, select the photo, select Delete, then retake it, but this time, crop the 
image manually by selecting Edit and Crop.

7. Optionally, select a photo and select Delete to delete it. Select Add to add another photo. 
Select Close when done.

8. Select Send.
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Capture existing photos
1. On your Android phone or tablet, open the Printix App.
2. Select Menu  > Capture.

• Alternatively, you can select Capture  on the Print page.
3. Select a box with the appropriate settings.

Example:
• File type: PDF
• Image quality: Medium
• Destination: Email

4. Select Gallery.
5. Select the photo.

• If you do not want to proceed, select X to cancel and return to the list of boxes.
6. Preview the photo. Optionally, select Edit to Crop or Rotate the image.
7. Select Use.

 If you did not crop the image, it is cropped automatically. If you are not satisfied with the 
automatic cropping, select the photo, select Delete, then select it again in the Gallery, but 
this time, crop the image manually by selecting Edit and Crop.

8. Optionally, select a photo and select Delete to delete it. Select Add to add another photo. 
Select Close when done.

9. Select Send.

Capture with iPhone and iPad

 Capture is intended for text-based documents and the output is delivered in black and white.

Use the camera to capture
1. On your iPhone or iPad, open the Printix App.
2. Select Menu  > Capture.

• Alternatively, you can select Capture  on the Print page.
3. Select a box with the appropriate settings.
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Example:
• File type: PDF
• Image quality: Medium
• Destination: Email

4. Follow the instructions, then take a photo.
• If you do not want to proceed, select X to cancel and return to the list of boxes.
• The built-in, automatic crop function works best if the document is placed on a darker 

background.
• Select the lightning icon to toggle the flashlight.
• If prompted, select Allow to allow the Printix App to take pictures.
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5. Preview the photo. Optionally, select Retake, or select Edit to Crop or Rotate the image.
6. Select Use.

 If you did not crop the image, it is cropped automatically. If you are not satisfied with the 
automatic cropping, select the photo, select Delete, then retake it, but this time, crop the 
image manually by selecting Edit and Crop.

7. Optionally, select a photo and select Delete to delete it. Select Add to add another photo. 
Select Close when done.

8. Select Send.
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Capture existing photos
1. On your iPhone or iPad, open the Printix App.
2. Select Menu  > Capture.

• Alternatively, you can select Capture  on the Print page.
3. Select a box with the appropriate settings.

Example:
• File type: PDF
• Image quality: Medium
• Destination: Email

4. Select Gallery.
5. Select the photo.

• If you do not want to proceed, select X to cancel and return to the list of boxes.
6. Preview the photo. Optionally, select Edit to Crop or Rotate the image.
7. Select Use.

 If you did not crop the image, it is cropped automatically. If you are not satisfied with the 
automatic cropping, select the photo, select Delete, then select it again in the Gallery, but 
this time, crop the image manually by selecting Edit and Crop.

8. Optionally, select a photo and select Delete to delete it. Select Add to add another photo. 
Select Close when done.

9. Select Send.

Recents
On this page, you can reprint documents that were deleted or printed within the previous 12 hours. 
The page works the same as the Print page. You can reprint to one printer at a time.
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1. Select the documents.
2. Select Print at the bottom of the page.

• To return to the Print page, select the Blue clock .
• To permanently delete a recent document, select the document and select Delete .

History - Print
See which documents you printed during the previous 30 days.

Until a document is deleted, it appears with its document name. After it is deleted, the document 
appears with an ID.
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History - Capture
See information about your completed and failed capture workflows for the previous 30 days.
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Cards and codes
To get here, select Menu  > Cards and codes in the Printix App.
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Manage the cards, ID code, and PIN code used to sign in at printers that have Printix Go installed.

It may take a few seconds for the page to load.
• PIN code:

• Create and reset the PIN code
• ID code:

• Create and reset the ID code
• Cards:

• Select Register card to register a card.
• Select Delete  next to a card to delete it.

Create and reset the PIN code
The PIN code is the same whether you sign in with an ID code or card.

1. Sign in to the Printix App.
2. Select Menu  > Cards and codes.
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3. Select Create next to PIN code.
4. Enter a new PIN code (4 digits), then select Save.

• Select Reset next to PIN code and enter a new PIN code to replace the old one.
• Select Delete  next to your PIN code to delete it.

 The message PIN code disabled appears after three consecutive, failed sign-in attempts. 
In this case, you must open the Printix App, reset the PIN code, and enter a new and different 
value. Otherwise, the Printix App displays The new PIN code must be different from the 
previous one.

Create and reset the ID code
Use the ID code to sign in at printers that have Printix Go installed.

1. Sign in to the Printix App.
2. Select Menu  > Cards and codes.
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3. Select Create next to ID code to get an ID code.
4. If you see PIN code required, select Create, enter a new PIN code (4 digits), then select Save.

• Select Reset next to ID code and enter a new ID code to replace the old one.
• Select Delete  next to your ID code to delete it.

Change home
Selecting a Printix Home is relevant when you sign in to the Printix App for Android or iOS/iPadOS. 
You are prompted to select a Printix Home if you:
• Sign in with Microsoft, and Microsoft Entra ID is used with multiple Printix Homes.
• Sign in with Google, and Google Workspace is used with multiple Printix Homes.
• Sign in with Okta, and Okta is used with multiple Printix Homes.
• Sign in with OneLogin, and OneLogin is used with multiple Printix Homes.
• Sign in with email, and your Printix account is registered with multiple Printix Homes.

Printer ID method
This function is relevant if you want to disable some of the available printer ID methods.

1. Select the methods to be available:
• QR code
• NFC tag

Not available if the phone is not NFC-enabled.
2. Select OK.
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AirPrint password
You need the AirPrint password if you see the "Password required for {printer}" dialog box. This 
feature requires your administrator to enable mobile print.

 Your AirPrint password is the same for all printers. You need to enter your AirPrint password 
only once per printer.

See How to get your AirPrint password.

Diagnostics
Diagnostics are relevant if you are advised to get and submit the logs to Support personnel.

See also:
• How to get Printix App logs
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Chapter 6

Printix Go

Printix Go is an application that integrates with your printer's touchscreen control panel, offering 
secure print release, copy control, card-based authentication, and more.

• Sign in with an ID code at the printer
• Sign in with card at the printer
• Release documents at the printer
• Capture at the printer
• Sign out
• Register a card
• Forgot the ID code or PIN code
• Create and reset the ID code
• Create and reset the PIN code

You can use Printix Go with the following printers:
• Brother
• Epson
• Fujifilm
• HP
• Konica Minolta
• Kyocera
• Lexmark
• Ricoh
• Xerox

Sign in with an ID code at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Enter your ID code (6 digits) on the touchscreen.
• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• This step is skipped if your administrator configured that users only need an ID code to sign 

in.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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See also:
• Create and reset the ID code
• Create and reset the PIN code

Sign in with card at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Swipe your card at the card reader on the printer.
• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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See also:
• Register a card
• Create and reset the PIN code

Release documents at the printer
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Sign in to the printer.

79



Tungsten Printix User Guide

2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at the printer
These are generic instructions. For vendor-specific instructions, see: HP, Konica Minolta, Kyocera, or
Ricoh.

The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.
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• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• On Ricoh, you cannot log out from the printer while the printer is scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

Sign out
These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.
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Register a card
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

These are generic instructions. For vendor-specific instructions, see: Brother, Epson, Fujifilm, HP,
Konica Minolta, Kyocera, Lexmark, Ricoh, or Xerox.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card without a phone.

• Make a note of the 6-digit card registration code and enter it later in the web Printix App 
on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register a card without a phone
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.
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A 6-digit card registration code appears. The code is valid for 1 hour.

2. Make a note of the card registration code.

Enter card registration code on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.
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3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Forgot the ID code or PIN code
You can reset the ID code or PIN code from the Cards and codes menu in the Printix App. The 
printer's sign-in screens that prompt for the ID code and PIN code also include a Forgot code
button.

1. Select Forgot code.
A new screen appears with a QR code and the text: Scan QR code or visit {acme.printix.net}.
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2. Use your phone or tablet to scan the QR code to open the Cards and codes menu in the Printix 
App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• If the Google application is installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.

 The message PIN code disabled appears after three consecutive, failed sign-in attempts. 
In this case, you must open the Printix App, reset the PIN code, and enter a new and different 
value. Otherwise, the Printix App displays The new PIN code must be different from the 
previous one.

See also:
• Create and reset the ID code
• Create and reset the PIN code

Use Printix Go on Brother printers
• Sign in with an ID code at a Brother printer
• Sign in with card at a Brother printer
• Release documents at a Brother printer
• Sign out from a Brother printer
• Register card on a Brother printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Brother printer
1. When the printer's touchscreen control panel displays Press OK to sign in or Present card or 

press OK, select OK.
2. Select ID code.

• If you do not know your ID code:
• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 

or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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3. Enter your ID code (6 digits) on the touchscreen.
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4. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Return to the screen where you selected ID code, but instead of selecting ID code, select
Forgot code to open a new screen with a QR code. Use the camera on your phone or 
tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

Sign in with card at a Brother printer
1. When the printer's touchscreen control panel displays Present card or press OK, swipe your 

card at the card reader on the printer.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
2. If prompted, enter your PIN code (4 digits) on the touchscreen.

• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Return to the screen where the control panel displays Present card or press OK, select
OK, then select Forgot code to open a new screen with a QR code. Use the camera on 
your phone or tablet to scan the QR code to open the Cards and codes menu in the
Printix App, or browse to the URL provided to reset your PIN code.
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Release documents at a Brother printer
1. Sign in to the printer.
2. Select Solutions.
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3. Select Select to print to only release specific documents, or select Print all to release all 
documents.

4. Select the documents to release, or select Select all.
The other documents are not visually marked with a check mark if you use Select all.
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5. Select OK at the bottom of the screen.

Delete documents
1. Sign in to the printer.
2. Select Solutions.
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3. Select Select to delete.
4. Select the documents to delete, or select Select all.
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5. Select OK at the bottom of the screen.

Sign out from a Brother printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select the signed in user's name in the upper left corner.

Register card on a Brother printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
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4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.
Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Use Printix Go on Epson printers
• Sign in with an ID code at an Epson printer
• Sign in with card at an Epson printer
• Release documents at an Epson printer
• Sign out from an Epson printer
• Register card on an Epson printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code
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Sign in with an ID code at an Epson printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at an Epson printer
1. Swipe your card at the card reader on the printer.

• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 
happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

102



Tungsten Printix User Guide

Release documents at an Epson printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Home icon on the printer.
3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from an Epson printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on an Epson printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 

104



Tungsten Printix User Guide

registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.
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Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Use Printix Go on Fujifilm printers
• Sign in with an ID code at a Fujifilm printer
• Sign in with card at a Fujifilm printer
• Release documents at a Fujifilm printer
• Sign out from a Fujifilm printer
• Register card on a Fujifilm printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Fujifilm printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Fujifilm printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Fujifilm printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Fujifilm printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Fujifilm printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.
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2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

113



Tungsten Printix User Guide

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Use Printix Go on HP printers
• Sign in with an ID code at an HP printer
• Sign in with card at an HP printer
• Release documents at an HP printer
• Capture at an HP printer
• Sign out from an HP printer
• Register card on an HP printer
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See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at an HP printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at an HP printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

117



Tungsten Printix User Guide

Release documents at an HP printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Print  icon.

On HP Workpath printers, the icon is called Printix Go.
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3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at an HP printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
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The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

Sign out from an HP printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.
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Register card on an HP printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.
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3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Use Printix Go on Konica Minolta printers
• Sign in with an ID code at a Konica Minolta printer
• Sign in with card at a Konica Minolta printer
• Release documents at a Konica Minolta printer
• Capture at a Konica Minolta printer
• Sign out from a Konica Minolta printer
• Register card on a Konica Minolta printer
• Sign in as guest on a Konica Minolta printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Konica Minolta printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
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• If you do not know your ID code:
• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 

or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Konica Minolta printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Konica Minolta printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Printix Print  icon.

3. Select the documents to release, or select Select all (the check box in the top right corner).
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4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Konica Minolta printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.
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A list of capture workflows appears.

3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.
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4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.

5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

Sign out from a Konica Minolta printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select the printer's Access button.

Swiping your card at the printer's card reader to sign out is not recommended, because the printer 
cannot detect if the card belongs to an already signed in user.
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Register card on a Konica Minolta printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.
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3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Sign in as guest on a Konica Minolta printer
1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 

panel.

2. Select a function to use, such as Copy if that is available.
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Use Printix Go on Kyocera printers
• Sign in with an ID code at a Kyocera printer
• Sign in with card at a Kyocera printer
• Release documents at a Kyocera printer
• Capture at a Kyocera printer
• Sign out from a Kyocera printer
• Register card on a Kyocera printer
• Sign in as guest on a Kyocera printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Kyocera printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.
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2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Kyocera printer
1. Swipe your card at the card reader on the printer.

139



Tungsten Printix User Guide

2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.

Release documents at a Kyocera printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Kyocera printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.

Sign out from a Kyocera printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Kyocera printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.
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A 6-digit card registration code appears. The code is valid for 1 hour.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
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• With the Google application installed on your Android phone or tablet, you can perform a 
Google screen search to scan the QR code.

• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 
that option.

2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Sign in as guest on a Kyocera printer
1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 

panel.
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2. Select a function to use, such as Copy if that is available.

Use Printix Go on Lexmark printers
• Sign in with an ID code at a Lexmark printer
• Sign in with card at a Lexmark printer
• Release documents at a Lexmark printer
• Sign out from a Lexmark printer
• Register card on a Lexmark printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Lexmark printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
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• If you do not know your ID code:
• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 

or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Lexmark printer
1. Swipe your card at the card reader on the printer.

• Before 60 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Lexmark printer
1. Sign in to the printer.
2. Before 60 seconds have elapsed, select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Lexmark printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Lexmark printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
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Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
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2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.

Use Printix Go on Ricoh printers
• Sign in with an ID code at a Ricoh printer
• Sign in with card at a Ricoh printer
• Release documents at a Ricoh printer
• Capture at a Ricoh printer
• Sign out from a Ricoh printer
• Register card on a Ricoh printer
• Sign in as guest on a Ricoh printer

See also:
• Register and delete cards
• Create and reset the PIN code
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• Create and reset the ID code
• Forgot the ID code or PIN code

Sign in with an ID code at a Ricoh printer
1. Enter your ID code (6 digits) on the touchscreen.

• Select the Eye  to see the digits entered.
• If you do not know your ID code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your ID code.

2. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Sign in with card at a Ricoh printer
1. Swipe your card at the card reader on the printer.

• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 
happens when the card is swiped.

• If another user was signed in, swiping your card started to sign out that user. Wait until the 
sign-out process is completed, then swipe your card again.
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2. If prompted, enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• Select the Eye  to see the digits entered.
• If you do not know your PIN code:

• Select Forgot code to open a new screen with a QR code. Use the camera on your phone 
or tablet to scan the QR code to open the Cards and codes menu in the Printix App, or 
browse to the URL provided to reset your PIN code.
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Release documents at a Ricoh printer
1. Sign in to the printer.
2. Select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.
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Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Capture at a Ricoh printer
The capture process consists of three steps:
• Scan and upload

As soon as the document is scanned and uploaded, you are returned to the list of workflows, 
while the processing and delivery continue in the background.

• Processing
The scanned document is processed by Optical Character Recognition (OCR) and a searchable 
PDF or Microsoft Word file is created.

• Delivery
The document is sent in email, transferred to a cloud destination (OneDrive or SharePoint), or 
transferred to a Connector destination.

1. Sign in to the printer.
2. Select the Printix Capture  icon.

A list of capture workflows appears.
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3. Select the appropriate workflow.
If you are signed in with the System manager role, the Active information (Yes or No) is 
displayed.

4. Confirm the details of the workflow and place the document in the printer:
• Place multi-page documents in the Automatic Document Feeder (ADF).

Ensure pages are in the correct order.
• Place one-page documents on the printer's flatbed glass.

Scanning multiple pages from the flatbed glass is not supported.
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5. Select Start to start scanning.
• If you do not want to start the scan, select X to cancel and return to the list of workflows.
• You cannot log out from the printer while the printer is scanning.
• As soon as the document is scanned and uploaded, you are returned to the list of workflows, 

while the processing and delivery continue in the background.

Sign out from a Ricoh printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for a set amount of time, 
you are signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.

Register card on a Ricoh printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
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registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.

Make a note of the 6-digit card registration code and enter it later in the web Printix App on 
your computer.

2. Register your card using one of the following methods:
• Scan the QR code with the camera on your phone.
• Scan the QR code with the Printix App on your phone.
• Register the card on your computer.

Scan the QR code with the camera on your phone
1. Use the camera on your phone or tablet to scan the QR code displayed on the printer's 

touchscreen.
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Scanning the QR code opens the web Printix App in your browser and registers the card. You 
may be prompted to sign in to the web Printix App.
• With iOS/iPadOS 11 or higher, you can use the camera to scan the QR code.
• With the Google application installed on your Android phone or tablet, you can perform a 

Google screen search to scan the QR code.
• If your QR scanner app (not part of Printix) prompts you to open the link in a browser, select 

that option.
2. Select Close.

Scan the QR code with the Printix App on your phone
If you are using the Printix App on your phone or tablet, you can:

1. Open the Printix App for Android or iOS/iPadOS.
2. Select Menu  > Cards and codes.
3. Select Register card.
4. Select Scan , then point the camera to the QR code displayed on the printer's touchscreen.

Alternatively, you can enter the 6-digit card registration code you saw previously and select
Save.

Register the card on your computer
1. Open the Printix App.
2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.
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Sign in as guest on a Ricoh printer
This option requires Printix Go Ricoh version 2.0.0.27 or higher.

1. On the sign-in page, select Guest  in the upper right of the printer's touchscreen control 
panel.

2. Select a function to use, such as Copy if that is available.

Use Printix Go on Xerox printers
• Sign in with an ID code at a Xerox printer
• Sign in with card at a Xerox printer
• Release documents at a Xerox printer
• Sign out from a Xerox printer
• Register card on a Xerox printer

See also:
• Register and delete cards
• Create and reset the PIN code
• Create and reset the ID code
• Forgot the ID code or PIN code
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Sign in with an ID code at a Xerox printer

 The authentication on Xerox AltaLink printers has a different visual design than on other Xerox 
printers, but they have the same functions.

1. Select the Keyboard icon in the top right corner.

2. Enter your ID code (6 digits) on the touchscreen.
• If you do not know your ID code:

• Open the Cards and codes menu in the Printix App.
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3. Enter your PIN code (4 digits) on the touchscreen.
• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Open the Cards and codes menu in the Printix App.
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Sign in with card at a Xerox printer
1. Swipe your card at the card reader on the printer.

• Before 90 seconds have elapsed, select the Printix Print  icon.
• A computer with Printix Client must be online on the printer's network. Otherwise, nothing 

happens when the card is swiped.
2. If prompted, enter your PIN code (4 digits) on the touchscreen.

• The PIN code is the same whether you sign in with an ID code or card.
• If you do not know your PIN code:

• Open the Cards and codes menu in the Printix App.
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Release documents at a Xerox printer
1. Sign in to the printer.
2. Before 90 seconds have elapsed, select the Printix Print  icon.
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3. Select the documents to release, or select Select all (the check box in the top right corner).

4. Select Print at the bottom of the screen.

Delete documents
• Select the documents to delete and select Delete .
• Documents are automatically deleted if you do not print them within a specified period (default is 

24 hours).

Sign out from a Xerox printer
You can sign out from the printer using these methods:
• Automatic sign-out if no activity.

• If the printer does not register key presses or touchscreen activity for 90 seconds, you are 
signed out automatically.

• Select Sign out on the printer's Home screen.
• To access the printer's Home screen, select the Home button.

• Swipe your card at the card reader on the printer.
• If you were already signed in, you are signed out. If another user was signed in, that user is 

signed out and you must swipe your card again to sign in.
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Register card on a Xerox printer
You can register multiple cards. When your card is registered, the date and time of the registration 
is recorded together with the card number. If different card readers are used, the same card can be 
registered with different formats (card numbers). In this situation, you can register the same card 
with each type of card reader.

1. Swipe the card at the card reader on the printer.

A 6-digit card registration code appears. The code is valid for 1 hour.
2. Make a note of the 6-digit card registration code and select Home to close the screen.

Alternatively, you can close the screen by:
• Selecting Exit and then Cancel.
• Selecting No/Yes and then OK.

Enter card registration code in the Printix App
1. Open the Printix App.
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2. Select Menu  > Cards and codes.

3. Select Register card.
4. Enter the 6-digit card registration code you saw previously and select Save.
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Frequently asked questions

This topic contains answers to the following frequently asked questions:
• Why are printers named ASD, BNM?
• What are the benefits of Printix?
• Can I print while my Internet connection is lost?
• What does it cost in data traffic to use my phone?
• Are documents stored on my phone?

Why are printers named ASD, BNM?
The name of all Printix printers is automatically extended with a unique, three-letter ID, also known 
as the printer ID. This ID makes it efficient to search for printers and easy to identify the printers.
• Searching for a printer is efficient.

• If Printix manages 26 or fewer printers, you need to only enter the first letter when searching 
for a printer.

• The search is not case-sensitive.
• Identifying the printer is made easy.

• The printer ID sign mounted on the physical printer includes the printer ID.
• Print queues are named so they include the printer ID.

How many printers can be supported?
Up to 2200 printers can be assigned with three-letter IDs. If more printers are added, the software 
automatically uses four-letter IDs.

Keyboard sequence
The sequence of letters for the first 78 printer IDs are grouped together on the keyboard to 
optimize searching for printers by their ID.

Printer ID examples:
• Reception ASD
• Sales BNM

Keyboard sequence for printers ASD and BNM
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What are the benefits of Printix?
As a user, Printix gives you flexibility to:

• Print when and where you want
Print Anywhere makes it possible to roam between printers and release the document at the 
printer you choose.

• Prevent others from collecting your documents at the printer
Wait until you arrive at the printer, then release the documents using your phone. That way, you 
prevent others from collecting your confidential and sensitive documents.

• Make fewer visits to the printer
Submit documents to a print queue, but postpone the printing and collection of the documents 
until it suits you to release them.

• Delete unwanted documents from the print queue
You can use your phone, tablet, or computer to delete unwanted documents from the print 
queue before they are printed. Without Print Later, such documents would go straight from the 
printer's output bin to the wastepaper basket.

• Reprint documents
You can reprint documents until 12 hours after they are marked for deletion. You can reprint 
documents straight from your phone without having to return to your computer to reprint them.

Printix also creates a win-win situation for your organization and the environment:

• Reduced printing saves on paper and toner
By minimizing the number of printed documents, your organization saves money on paper, 
toner, maintenance, and electricity.

• Environmental benefits
Fewer trees are cut down to produce paper, thus reducing the carbon footprint and water usage.
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Can I print while my Internet connection is lost?
Yes. In most cases, you can continue to print while the Internet connection is lost, but functionality 
is limited.

Without an Internet connection, you are temporarily unable to:
• Sign in to Printix.
• Add printers.
• Access online documentation.
• Release documents.
• Reprint recent documents.

As long as you remain signed in and keep your computer powered on, you can:
• Print directly to printers on the network.
• Print with Print Anywhere, but you cannot release any documents.

• The Printix Client displays the message Printix is currently offline. Your document {file name} 
can be released when Printix is online again.

• If your administrator enabled the Allow direct print if offline setting, the Printix Client displays 
the message Printix is currently offline. You cannot release your document from Printix 
Anywhere until Printix is online again. Consider printing your document now by selecting a 
different printer, and it prompts you to select a printer. Printers are listed only if they are on 
the same network as your computer, AND if you have previously released documents to them.
If you select Printix Anywhere, your document can only be released when the Internet 
connection is restored. Alternatively, you can print your document immediately at another 
printer that is listed.

• Print with Print Later, but you cannot release any documents.
• If your administrator enabled the Allow direct print if offline setting, the Printix Client displays 

the message Printix is currently offline. If you select Print Later, you can only release your 
document when Printix is online again, and it prompts you to print now or use Print Later.
If you still decide to use Print Later, your document can only be released when the Internet 
connection is restored. Alternatively, you can Print the document immediately at the printer 
you originally selected.

• If your administrator did not enable the Allow direct print if offline setting, the Printix Client 
displays the message Printix is currently offline. Your document {file name} can be released 
when Printix is online again, and it does not prompt you to make a choice.

If your Internet connection is lost and the printer is also unreachable (for example, it is offline or on 
another network), the print fails, then the Printix Client displays the message Document {file name} 
deleted. Your document cannot be printed, because Printix Client is offline and cannot reach the 
target printer ({printer name}).

When the Internet connection is restored, all functionality is working again and you can:
• Release documents

Including any Print Anywhere and Print Later documents you submitted while the Internet 
connection was lost.
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• Reprint documents
Including any documents you submitted with direct print while the Internet connection was lost.

What does it cost in data traffic to use my phone?
Very little, and you can save on your phone's monthly data allowance by connecting to the local Wi-
Fi whenever possible.
• The Printix App phone traffic consists of small amounts of control data and does not include print 

data.
• 3 KB per session to sign in
• 0.2–0.3 KB per document
• 400 KB to gain Internet access through 3G/4G/5G

• Print data is sent directly to the printer without involving the phone.

Are documents stored on my phone?
No, documents are not stored on your phone or tablet. Documents are typically stored on your 
computer, and they remain encrypted until expiration or deletion. So, you do not have to worry 
about your phone running out of space.
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Error messages

In this topic, you can read about possible error causes and solutions.
• If you have sign-in issues, see the following diagram for instructions:

• Print issues
• User name or password is wrong
• Connecting to service
• Fetching data
• Permission denied
• Wrong ID code
• Wrong PIN code
• Http failure response for (unknown URL): 0 Unknown Error

Print issues
As you release documents in the Printix App, you may encounter the following issues:
• Printing failed
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• Document is unavailable
• Release not possible
• Release failed
• Unable to perform action while Printix Client is on an unknown network
• Timeout
• When I release a document, the Printix App displays 'Working on it'
• Submitted document does not appear in the Printix App
• Printix App displays 'Document release is not possible at the moment due to system error'
• Printix App displays 'Internal error'

Printing failed
Resolution: Confirm the following requirements, then try to resolve the issue.
• Ensure that the printer is online.
• Ensure that the printer is not paused, jammed, or out of paper, and that it has no other issues.

If you see the message "Printing failed - retrying", repeated attempts are made for up to 30 minutes 
to deliver the print data to the printer.

Document is unavailable
In the Printix App, you may notice the following scenario:
• One or more selected documents are labeled: Document is unavailable.
• After selecting all documents, an Unavailable documents dialog box appears with the question:

Deselect unavailable documents?

The preceding behavior is expected and happens because the Printix App checks if printing is 
possible based on the availability of the selected printer and documents. The Printix App considers 
whether the selected documents are stored in the cloud or on a computer. If the document is 
stored on a computer that is not reachable from the selected printer, then the document is labeled:
Document is unavailable. If Select all is used to select documents (including unavailable ones), 
the Unavailable documents dialog box appears and you can select OK to deselect the unavailable 
documents.

Resolution: Deselect the unavailable documents.

Release not possible
If the computer is connected through a weak Wi-Fi signal, the connection may have been 
temporarily lost at the time of release.

Resolution: Ensure that the computer with the document is online, then try to release the document 
again.
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Release failed
Resolution: Confirm the following requirements, then try to resolve the issue. Printix attempts to 
print the document when the issue is resolved.
• Ensure that the computer with the document is online.
• Ensure that the printer is online.
• Ensure that the printer is on the same network as the computer.
• Ensure that the printer is not paused, jammed, or out of paper, and that it has no other issues.

Unable to perform action while Printix Client is on an unknown network
• You are trying to release a document to a printer at the office while you are traveling or at home.
• When the computer is on an unknown network, a yellow dot appears on the Printix Client icon .

Resolution: Wait until your computer is connected to a known and trusted network, then release the 
document. Alternatively, print the document directly to the printer.

Timeout
Resolution: Confirm the following requirements, then try to release the document again.
• Ensure that the computer with the document is online.
• Ensure that the document did not expire before you tried to release it.
• If you were releasing a Print Anywhere document to a printer that does not support PDF, then the 

computer was not able to add the required print queue within the expected time. Wait 5 minutes, 
then try to release the document again.

When I release a document, the Printix App displays 'Working on it'
• If you are releasing a Print Anywhere document to a printer you did not use before, it may require 

your computer to first add the printer. This may take 1–5 minutes depending on the print driver. 
During this time, the Printix App displays the state Working on it before transitioning to Printing
and then Printed. The printer is kept after printing, so it does not have to be added again when 
you release subsequent Print Anywhere documents.

Resolution: Wait for the print queue to be created.

Submitted document does not appear in the Printix App
• In Printix Client and Printix App, look at who is listed as Signed in as and verify that it is the same 

user.

Resolution: Sign in as the same user in Printix Client and Printix App.
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Printix App displays 'Document release is not possible at the moment due 
to system error'

• An issue occurred with the Printix Cloud and therefore, it is not possible to release documents 
from the Printix App. You can check the Announcements section on the Printix website and look 
for any ongoing system errors.

Resolution: Try again when the system error is fixed.

Printix App displays 'Internal error'
• An internal error occurred in the Printix App. Select the message to see the details. If the issue 

continues, take a screen shot and submit a support request.

Resolution: Stop and restart the Printix App.

User name or password is wrong
Sign-in reports: Username or password is wrong.

Resolution: Enter your correct user name and password. If you registered with your email address, 
enter your email address as the user name.
• See also: How to reset your password

Connecting to service
The Printix Client is trying to connect to the Printix Service on the computer. The message typically 
appears for a few seconds, followed by the message: Fetching data. However, if the message is 
displayed for several minutes, it could be because the Printix Service is stopped.

Resolution: Contact your administrator if the issue persists. The administrator can refer to the
Printix Administrator Help for additional instructions.

Fetching data
• Trying to fetch data from the printer, or the Printix Client is trying to contact the Printix Cloud.
• Verify that you can reach the printer, that is, you can ping the printer from a computer with 

Printix Client on the printer's network.

Resolution: Wait until data has been fetched. Submit a support request if the issue persists.
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Permission denied
• You are trying to sign in to Printix Go, but your ID code or PIN code is incorrect.

Resolution: Open the Printix App and check your ID code and if necessary, reset your PIN code.
• You are trying to sign in to Printix Go with card, but your PIN code is incorrect.

Resolution: Open the Printix App and reset your PIN code.

Wrong ID code
You attempted to sign in at the printer (Printix Go), but you entered the wrong ID code.

Resolution: Try again, but this time, select the Eye  to see the digits entered and verify that they 
are the correct digits.

See also:
• Sign in with an ID code at the printer
• Create and reset the ID code

Wrong PIN code
You attempted to sign in at the printer (Printix Go), but you entered the wrong PIN code.

Resolution: Try again, but this time, select the Eye  to see the digits entered and verify that they 
are the correct digits.

Other PIN code messages:
• PIN code disabled

This message appears after three consecutive, failed sign-in attempts. In this case, you must 
open the Printix App, reset the PIN code, and enter a new and different value. Otherwise, the 
Printix App displays The new PIN code must be different from the previous one.

• Wrong PIN code. Remaining attempts: X
This message appears when the wrong PIN code is entered.

• You need to create a PIN code
This message appears if a PIN code is required but not yet created by the user. You must open 
the Printix App and create a PIN code.

See also:
• Sign in with an ID code at the printer
• Sign in with card at the printer
• Forgot the ID code or PIN code
• Create and reset the PIN code
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Http failure response for (unknown URL): 0 Unknown Error
Having more than 20 printers marked as favorites in the Printix App may result in the Error 
message: Http failure response for (unknown URL): 0 Unknown Error.

Resolution: Update to Printix App version 2.0.14 or open the Printers page and reduce the number 
of favorite printers by selecting the Solid star  to remove printers from the list of favorites.
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